Appendix A: Excel, the Basics!

Note: This tutorial was originally written for Excel 2003. There are a few additional instructions for the Excel 2007 version. As it does not fit all versions of excel, see the excel help files or ask a lab instructor if you need additional help.

We are going to walk through a few steps to practice (or learn) some important features in Excel. We are going to:

- define some Excel terminology
- learn how to enter data into a spreadsheet
- learn how to calculate mean and standard deviation from the data
- learn how to enter equations into a spreadsheet
- learn how to graph the data in the spreadsheet
- learn how to analyze the data based on the graph

First, the terminology:

When you create a new spread sheet in Excel, a page will show up with a grid on it. To the left of the grid, there are numbers designating which rows and to the top of the grid, there are capitol letters designating columns. Each box is referred to as a 'Cell' and we will consider the upper left cell to be the home cell. So, if you move 4 cells down and 3 cells to the right you would be in cell D5. Cell designations will be important when using equations.

Entering data:

The first task will be to type in some information. All you have to do for this is select a cell and start typing! A good thing to do first is to set up column headers. Simply go to cell 'A1' and type 'L1', cell 'B1' and type 'L2', cell ‘C1’ and type L2-L1. You can move between cells either by clicking on the new cell where you want to enter information, or by hitting the tab key or up/down/left/right arrows.

Now it is time to enter some data. Type your measurements of \( l_1 \) into one column, and \( l_2 \) into the next column.

Now, we want to calculate the difference between the two measurements, in order to calculate the length. Excel will do this for you! Select cell C2. Type the following:

\[ =B2 - A2 \]

Notice that as you type “B2”, cell B2 is highlighted, and as you type “A2”, cell “A2” is highlighted! Also notice that as you type in the cell, the equation appears in the formula bar at the top. Now, hit enter, and the difference between the values in cells B2 and A2 will appear…in cell C2!

Now, you want to calculate the difference for each of your pairs of measurements. You could repeat the method we just described, for every row of your data, a very tedious method, but Excel does have way to speed up this process. The first step to unlock this secret is to select cell
C2. Then hit “control C” on the keyboard to select this cell. (You are actually selecting the equation associated with the cell.) Now select cells C2 through C10 (or however many rows of data you have), and hit “control V” on the keyboard. You have just pasted the equation into all the rows! Each cell in column C now contains the difference between the corresponding rows in column B and column A!

What about calculating the average (mean) and standard deviation? Do this by hand, with your calculator (you can do that at home). It is annoying and tedious, but we want you to do it … just this once. The easier way is with Excel, of course. Suppose you want to put the average value of your measured lengths in cell C11 (or whatever is your first empty cell in column C). Select this cell. Now type this:

=AVERAGE(C2:C10)

and hit Enter. The average (mean) of cells C2 through C10 will appear in cell C11! (Another trick: instead of typing “C2:C10”, you can select cells C2 through C10, and the cell numbers will automatically appear in your equation!)

What about the standard deviation? Select the cell where you want the standard deviation to appear. Go up to the formula bar, and type:

=STDEV(C2:C10)

Now hit Enter, and the standard deviation of the numbers in cells C2 through C10 will appear!

You may want to set up your data tables so that they display the correct number of significant digits. To do this, select the cells you want to change. Right click on the selection, and choose ‘Format Cells’. Under the ‘Number’ tab, choose ‘number’, and choose the number of decimal places you want to keep.

Also, you can set up your table with borders. Again, select all the cells you want to put a border around. Right click in the selection, and choose the ‘border’ tab. Click the ‘outline’ and ‘inside’ buttons, then ok.

Practice Creating a Graph (Using Pretend Data):

Now, let’s do something a bit more complicated. Let’s enter some “pretend” data. Suppose a ball is rolling down an inclined plane. You measure its position at various different time points. Suppose you measure time from 0 seconds to 50 seconds, in increments of 1 second. Let’s enter that data in column D. First, set up column headers. Go to cell D1 and enter “Time”. Go to cell E1 and enter “Position”. Go to cell F1 and enter “Velocity”. Go to cell G1 and enter “Acceleration”.

There are 2 ways to enter the time data. The obvious one would be to go to cell 'D2' and type 0, then cell 'D3' and type 1, etc… Again, a very tedious method, especially at the end of a long day when you want to go home! Again, Excel does have way to speed up things up. Enter 0
in 'D2' and 1 in 'D3'. Next highlight cells 'D2' and 'D3' (do this by clicking on one cell and dragging over to the other). Once you have selected the two cells, let go of the mouse buttons. You will notice in the lower right corner of cell 'B4' there is a small black square. Move the mouse over this square and you will notice that your cursor changes from a white thick plus sign to a black thin plus sign. Once the cursor changes to this black plus sign you can click and drag straight down about 50 cells. You should notice to the right of the mouse a box with a number in it appears. This number represents the value that Excel will enter into the cell for you. When you see that number reach 50, you can let go of the mouse and, like magic, all the cells will be filled with the values you would have otherwise had to type in yourself. This process is known as autofilling.

Now, let’s work with an equation. Just like what we did for the length data before, to enter an equation, you simply have to choose a cell and hit the '=' key. This tells Excel that you want to use an equation in that cell. The equation you are typing will appear in the function bar as you type it in the cell.

Go to cell ‘E2’ and hit the '=' key. After the '=' you are free to enter any equation into the cell. For our purposes, we will use the equation "-0.1*t^2+4*t", where '^' designates the use of a power. This equation may seem strange, but you will see it in class in a few days. It shows how position changes as a function of time for something that is moving at a constant acceleration. Since our times are in column D, the equation we need, in terms that Excel will understand, is

\[ -0.1*D2^2+4*D2 \]

Now hit Enter, and a number will appear in cell E2. Excel has taken the value in cell 'D2' and entered it into your equation. Does the value that showed up make sense? Check it with a calculator.

Now that you have your equation, you can manually type it into each cell or you can use the method for autofilling described before. The only difference is that this time you will not select multiple cells. The reason you selected multiple cells in the previous step was so that Excel could determine the pattern of the values you wanted. This time, you have an equation in cell E2, which already specifies a pattern. Simply click on the cell with the equation, move the mouse over to the lower right corner and click and drag until you will fill all the cells you have times for.

Do the same thing in column F (velocity) with the equation starting with '= -0.2*D2+4' in cell ‘F2’, and autofill the data into the rest of the columns.

Do the same thing in column G (acceleration) with the equation starting with '= -0.2' in cell ‘G2’ and autofill the data into the rest of the columns.
The 'manual' method of making a scatter plot of data (Vista version):

First, select any blank cell on the Excel spreadsheet to which you want to add a graph. Next, select the "Insert" tab near the top left of the Excel window. A row of new options will appear just below the tabs row. Near the middle of the row of options, you'll see a box labeled "Scatter". Select this and a drop down menu should appear with various scatter graph options. Select the "Scatter with only Markers" option (The options aren't labeled by name, but the associated picture looks like graphed polka dots. You can check the option by scrolling over the pictures and letting your mouse cursor sit for a second or two). After selecting the desired plot, a blank rectangle will pop up over some of your Excel worksheet, and a new row of options will appear just below the row of tabs.

The blank rectangle will house your plot, but to do so you'll need to first select your data. Select from the options row, "Select Data". A pop-up window "Select Data Source" will appear. Under the section labeled "Legend Entries (Series)" you'll have the choice to "Add", "Edit", "Remove", and two series ordering buttons (up and down arrows). Since no data was selected before opening "Select Data", no series will appear under "Legend Entries (Series)" (this is how the 'manual' method contrasts to the 'automatic' method).

To add a data series, select the "Add" button. A new pop-up window will appear, "Edit Series". Here, you can label your series by clicking in the blank space under "Series name:". Now you can enter what data you want to plot along your x axis and what data you want along your y axis. Your y values should always be your dependent variable while your x values should be the independent variable. In our case, time is the independent variable. Position, velocity, etc. are CALCULATED FROM TIME, and therefore they are dependent variables ("dependent" on time).

To choose the time column as the for the x axis, select the white space under "Series X values:". After clicking in the white box, you need to select the data from your spreadsheet. Simply click on the first value you want plotted and drag down to the last (select all 50 of your time values). When you let go of the mouse button the appropriate code will be entered into the box for you. (Excel won't know what to do if you select multiple rows or columns, so it may fuss at you). Once your desired row OR column is selected, you'll notice that the white space under "Series X values:" is filled in. Next do the same procedure for the box next to 'Y Values:' To do so, select the white space under "Series Y values:". Delete}{1} from this space. Now, you may click and drag over a row OR column on your worksheet which you want to plot along the y-axis, for example, position data. The white space under "series Y values:" will be filled in after you've made your selection, which SHOULD mean you are done selecting some data. Click the "OK" button on the "Edit Series" pop-up window to return to the "Select Data Source" window. Notice that the series you just selected from the worksheet is now under "Legend Entries (Series)".

We now want to add more series to the graph, one for time vs. velocity, and another for time vs. acceleration. To do this simply, right-click on the chart and select 'Source Data' from the menu. This will bring up the window we saw in the previous steps. You can rename or select alternative data for a series you have created by selecting your series first and then selecting
"Edit". Make sure you are on the series tab. Next add a new series and follow the same procedure to add the next columns. Your graph should end up with 3 series on it (i.e., 3 data plots). An example of what the graph should look like is shown on the following page.

The 'automatic' method of making a scatter plot of data (2007 version):

First, make sure the cell above each column of data is labeled (for example: above time values, make the cell just above the time data cells say "Time (*you insert appropriate units here*)"). Then, with your x-axis values on the left side of your data table (this should be the time values for this example 'experiment'), select ALL columns of data you'd like to plot. The rows to the right of the time column should be position, velocity, and acceleration for this example. Now, while this data table is selected, click the "Insert" tab from near the top left corner of the Excel window. Look for the "Scatter" button near the middle of the row of options. Then select the polka dots of data picture which should represent "Scatter with only Markers". Once you have selected this plot type, a graph should appear over your worksheet with your data series automatically plotted. And that's it besides adding a label for your x-axis and a plot title.

To add axis labels and a chart title (2007 Version):

First select your graph by clicking somewhere in the white space around the legend. Next, select the “Layout” tab. Near the mid left of the options row, the “Chart Title” option will allow you to input a chart title, and the “Axis Titles” option will allow you to input horizontal and vertical axis titles. Once you’ve selected your desired title(s), you can edit them by clicking on them in your graph.

Our final task, before you get to go home, is to add trendlines to the data. Trendlines are useful because they allow us to figure out an equation for data if we do not already know it.

To add a trendline, right-click on any one of the data points from the data set you want to add a trendline to. To add a trendline to the position data, right-click on any one of the position data points and a drop-down menu should appear. Select ‘Add Trendline’ from the list and a dialog box will appear. The screen that comes up should have a number of boxes with different types of equations you can fit to the data. Depending on which series you clicked on you will have to select the correct type of equation to fit to the data (parabola for position, straight line for velocity and acceleration). Once you have made this selection, click on the 'Options' tab at the top. Check the box next to 'Display equation on chart' so that you can actually see the equation Excel used to make the trendline. Click “ok”, and your graph should now have a trendline on it with a handy equation.

One more trick you can use is to add error bars to your data. To do this, click on any point in the data set you are interested in. Go to the Format menu, and click “Selected Data Series”. A menu will appear where you can select the error bars you want to add. This way you can plot data points and show their standard deviation on the same plot. Your plots should look something like the following graph:
\[ y = -0.1x^2 + 4x + 3 \times 10^{-14} \]

\[ y = -1 \times 10^{-17}x - 0.2 \]

\[ y = -0.2x + 4 \]

<table>
<thead>
<tr>
<th>Time (s)</th>
<th>Position</th>
<th>Velocity</th>
<th>Acceleration</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Poly.(Position)*

*Linear(Velocity)*

*Linear(Acceleration)*